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certainly doesn’t mean what it is supposed to mean. Too many programs
now don’t have proper text, and this one sure comes in that class. There are
bound to be more with the same sort of thing, and some of those will un-
doubtedly, and unfortunately, have worse results. Eventually, some of these
will probably get fixed eventually, but in the meanwhile, we will probably
just have to deal with crazy boxes.

If you have any crazy computer things, take a screenshot by pressing the
Print Screen button (sometimes labeled PrtScn or Print Scr) and send it to:
sobjornstad

@yahoo

.com.

(Split-line to prevent worms from getting the address)
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1: October 2005

Five Ways to Delete a File [September, October| (Until
November 2005)

e Click the X button on the toolbar.
e Click File>Delete.
e Press the ‘delete’ key.

e Right-click, choose ‘delete’.

Windows Explorer

Press (Windows key) '+ E to start.

Internet Explorer

Sorry, no more tips here till you switch to Firefox.

Firefox

Do you know how those browser windows always pile up? Have you ever
wanted more than one home page? Probably the answer is yes. Well, now
you can have lots of pages in one window and even have as many home pages
as you want. To get started, press the keystroke Ctrl + T. A new bar will
appear along the top. This is called the Tab bar. You can switch between
any pages you have open by clicking on the tab of that page. You can open
a new tab anytime by right-clicking on the Tab bar and clicking New Tab.

1There was a really terrible line drawing of the Windows logo here originally.
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Introduction

This book spans approximately six years of technical writing by me, begin-
ning with the first version of Windows Tips newsletter that I have on record
and ending with writing from barely a week ago, the latest thing I had at
press time.

Part I, Windows Tips, consists of eight issues of Windows Tips. Windows
Tips was a monthly (later semi-monthly) newsletter which contained tips
on Windows, Microsoft Word, Firefox, Internet Explorer, and random other
things. At some point, the column “Crazy Computers” was also added, which
was usually a rant on some stupid thing the computer had done to me over
the past month. Windows Tips ran for probably about two years—the issues
in this book run from October 2005 to December 2006. However, I've lost
quite a few other ones due to what I call my Hurricane File System—a term
which describes the utter disarray that all my files from before approximately
ninth grade are in. !

Part II, Technical Geekery Tips, contains the Technical Geekery Tips
newsletters from 2008. The newsletter also ran during 2009, but due to
both length and formatting issues, I decided to include only the first year.
Technical Geekery Tips was almost identical to Windows Tips, except for
the name and the fact that it was a fresh start. It also had a more regular
schedule than Windows Tips—I didn’t miss any issues at all in 2008, and did
fine for the first half of 2009 as well. After that I got behind, and that was
part of why I discontinued it at the beginning of 2010. (The other part was

1This happened partly due to poor organization, but also due to the fact that I rein-
stalled Windows probably seven or eight times during that time. My general practice upon
reinstalling the operating system used to be to place my old desktop and My Documents
folders in a folder called “Old” or something similar, which has led to up to five levels of
nesting in some places. Unsurprisingly, duplicate copies of everything abound, and so do
missing things—I have at least one file that I have four copies of, none of which contain
the entire document.
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16 2. DECEMBER 2005

won'’t be fixed, but that is a lot less to fix than typing the whole thing over.
You can use this for lots of case changes. But the best trick? To change
from a different case to sentence case, use the shortcut Alt + S-o-r-e-n-’-s +
Enter. Cool!

Note: You may hear some error beeps in the middle of the keystroke, but
nothing is wrong.

IE /Firefox

For Firefox non-users, you get a tip this month.

Ever wanted to get to a favorite website really fast? Sure, you could put it
in your Favorites or Bookmarks, but there is an even faster way. Right-click
the desktop, choose New Shortcut, and type the address into the box. Click
Next and type a name for your shortcut. Click Finish and put the shortcut
on your desktop or Quick Launch bar. Of course, it doesn’t have to be there.

Notepad (This may be the last time Notepad appears)

Think the font in Notepad is so dull? Well, it doesn’t have to show up
that way. Click Format>Font and choose something really snazzy or at least
something good enough to look decent, like Times New Roman.

Windows Explorer

OK, you have a folder full of pictures and want to see a slideshow. The task
pane isn’t out, and you have no idea how you are going to get a slideshow.
Right-click on the first picture, choose Open With, and choose Windows Pic-
ture and Fax Viewer. Make sure the window is selected, and press F11. It
is at the top of the keyboard close to the right, unless you have an archaic
keyboard. If you hate using keyboard shortcuts, the button is fifth from the
right and is a picture of a screen.

Bonus Tip: If you find a picture that needs to be rotated within a slideshow,
press Ctrl-L or Ctrl-R. If you don’t want to use the keyboard, right-click and
choose Rotate [direction].

29

I wish that Norton would be smart enough not to scan your drive when
it’s clear that you’re busy (or not try at all), that Office would not try to
convert my typing to fancy-looking characters, and that Windows Explorer
would turn that silly file protection off. I think the message “These Files
Are Hidden. This Folder Contains Files that Keep Your System Working
Properly” has stopped about 5 people from looking at their system folders.
Who exactly does Microsoft think they’re going to “protect”?

Sure, fixing Norton perfectly would be hard, but it would be easy to not
make it schedule an automatic scan and instead notify you when it was time
to scan. Fixing Word would be easy: just stop fancy conversions. Maybe
provide a way to turn them back on, too. As for “system file protection”, it
should be banished from the face of the earth. How about letting us see file
extensions and hidden files while they’re at it too, huh?* Microsoft is just
too stubborn. It has been proven in real-life tests that having file extensions
showing helps prevent viruses. And having them hidden can be confusing
because Windows only hides registered filename extensions.

The Clippit Column
Stop Clippit from talking to you automatically

Clippit may be annoying, but he can occasionally find topics that normal
Help just won’t find. But what about annoying “Do you want help with
this feature?” messages? And what about the infamous “It looks like you're
writing a letter” message? In many cases, the best thing to do is prevent
Clippit from coming up until you tell him to.

To do this, bring up Clippit by pressing F1 in Word, right-click on him,
choose Options, and uncheck all the boxes. Close Clippit (right-click him and
choose Hide Assistant), then restart Word. Clippit won’t come to see you
until you ask him to. For more details on disabling Clippit, see Computer
Central News.

4Microsoft still has yet to fix this problem (and I refuse to call it anything but a
problem). Incidentally, if you don’t know about file extensions, please open Windows
Explorer, press the Alt key, select Tools — Options — Folder Options — View, and turn
off “Hide extensions for known file types.” Although the chance of getting an email virus
this way is lower nowadays, not having file extensions visible to the user is just stupid.
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5: July 2006

Microsoft Word

Save time with a nearly undocumented toolbar

If you spend any time at all making tables in Word, you will love the Tables
toolbar. This toolbar can go anywhere and makes creating tables and borders
easy. To get started, right-click on the File menu, then check Tables and
Borders. A new toolbar will appear. Move it to wherever you want.

The Tables toolbar makes no provision for a normal table, but it provides
lots of ways to manipulate one that already exists. All the buttons towards
the right of the toolbar (which are grayed out unless you've selected a table)
are handy buttons that perform tasks that would normally necessitate going
to the Table menu.!

‘Web Development: Notepad or Word?

That’s a simple question and answer: neither. WordPad, a word processor
that comes with Windows, is great for HTML editing. If you're curious, ask
Soren.?

Windows Explorer

Views are important

1Originally there was a table of the functions of each button here. If you still use Word
2003, where there is a Tables toolbar that you might want to use, you can probably figure
it out yourself.

2Well, not many people do HTML editing in a text editor anymore. And I wouldn’t
recommend WordPad (or Notepad or Word) to do it.
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keyboard using the technique described. Note that not every symbol has a
code.

IE/Firefox

This month is a bit of an extension. All credit to Windows XP Hacks &
Mods for Dummies, Second Edition. It is a faster way to get the shortcut
described in last month’s tips.

Ever wanted to get to a favorite website really fast? Sure, you could put it
in your Favorites or Bookmarks, but there is an even faster way. Right-click
the desktop, choose New Shortcut, and type the address into the box. Click
Next and type a name for your shortcut. Click Finish and put the shortcut
on your desktop or Quick Launch bar. Of course, it doesn’t have to be there.

Well, even easier! See the little icon to the left of the URL? Drag it to
the desktop and you have a shortcut! *

Notepad (This may be the last time Notepad appears
{again})

NOTEPAD PRINTS VERY FUNNY! Okay, okay, it’s livable, but annoying.
It puts the filename at the top of each page. To get rid of this nonsense,

start Notepad, go to File>Page Setup, then delete the “&f” code symbol in
the box. This should take care of it.

General Windows

Keystroke-Lovers’ Tip: Alt-F4 will close any Windows program.

StatBar

Since StatBar has never been in here before, I am going to tell you a little
bit about it. The program can show you lots of things. I will suggest some
useful panels, but you can do anything you want. Right-click anywhere on
the bar and choose StatBar Configuration.

IThere were originally some screenshots here. They would be a big pain to include and
didn’t add much, so I left them out.

4: May 2006

Microsoft Word

I never thought I would be speaking against my own software, but here goes:
Don’t download or install the Improved template. It has several bugs in it,
and the installation is wrong. I plan to take it down soon.

IE/Firefox

The Google Toolbar is a handy add-on to both IE and Firefox. A fancy
feature about downloading it: the page autodetects whether you have IE or
Firefox and gives you the appropriate version.!

Download at: http://toolbar.google.com

Notepad (This isn’t a tip about Notepad)

Tip: Don’t get Ultra-Edit 32. It’s a nifty text editor, but hardly worth
$39.99.

Windows Explorer

Keep forgetting what buttons on your toolbar do? Add text to them. Right-
click on your toolbar and choose Customize. In the drop-down box that says
Text Options, choose Show Text Labels.

1The Google Toolbar was really cool in 2006, but now that every browser has built-in
search, it’s not really necessary.
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12. Get the Disk Info. It takes about 20 pixels, and clicking it tells you all
about your drives and also how much your machine and all removable

Hello, my name is James Duran. I live in Chicago, Illinois. I wanted
to know on a scale of one to ten, one being the worst, what you would

drives are together able to store and how much has been used.

Once you have added these, you should flip a few config switches.

1. Under Module Selection, choose Remember this selection when screen
resolution changes. Can’t live without it.

2. Under General Options, uncheck Open Website on logo double-click. I
have been transported to their site accidentally many times.

3. If you use XP, you may want to make it slightly transparent. If you
decide on it, choose 15

4. Networking just lets you choose a time server. Borrrrrring.

5. Enjoy StatBar!

Programs to Get
These programs will have a tip column in the future.

e StatBar- What a neat program! It well show you practically everything
about your computer. As an added bonus, it shows buttons to launch
programs. Cleaner desktop ahead!

Desktop Sidebar — The best add-on to the taskbar and desktop
ever! It has a performance space that can be added. Prepare,
though, to spend a few minutes customizing it. If you are
really crazy about what is on it, you may spend several hours.
(I did.) If you are low on screen space, you can set it to auto-
hide, even telling it a delay time between moving your mouse
to the side and it popping out.

Email Fraud Woes

This column will replace Crazy Computers this issue.

rate this program. I would give it an 8.
James Duran

How about this message for an attachment fraud? Like I would open this
attachment!

The attached PDF, How to Prevent Internet Fraud, will provide a little
bit of insight on avoiding email viruses and other email fraud. ?

NOTICES

Windows Tips is getting to be a pretty big thing. I just don’t have the time
to write a five-page newsletter every month. It will be scheduled for two
months; they may come out early, but don’t bet on it.

If anyone has a tip that they would like published, let me know! My ad-
dress is sobjornstad@yahoo.com. Feel free to email me about the newsletter
and/or your tips.

Please excuse the large size of Windows Tips. I am doing all I can to
keep the size to a minimum, but all these high-quality (though I'm working
on this too) pictures make the size shoot up fast.

Many people have probably missed the so-called “attached” file on the
Indexing Service last issue. It is in this series of attachments.

20nce again, I didn’t really feel like including this was worth it.
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Windows Explorer

Add cut and paste buttons to your toolbar.

Use cut and paste in Windows Explorer a lot? Add Cut, Copy, and Paste
items to the Windows Explorer toolbar. Press Windows + E to open Win-
dows Explorer, right-click the Up button and choose Customize. Find Cut
on the list and click the Add button. Repeat for Copy and Paste.

General Windows

The desktop is generally not a good place to store things permanently. Two
better places to put things are on the Quick Launch toolbar and the Start
menu.

Crazy Computers

Computers need constant troubleshooting

Computers crash. There seems to be no way around it. Microsoft does a lot to
hide the fact, including claiming Windows XP doesn’t have a Blue Screen of
Death, making all their error messages cryptic, calling BSODs “Stop errors”
and creating messages such as “Internet Explorer has encountered a problem
and needs to close. We are sorry for the inconvenience.”

I wish Windows didn’t have the Blue Screen of Death, but lying to its
customers about stability is quite another thing. And what about Microsoft
making a bad decision that could cause your computer to go into an endless
loop while starting? (The option in question is “Automatically restart”,
which causes Windows to restart whenever it encounters a BSOD.)

The Clippit Column

Office 2007 is (finally!) removing Clippit completely. Makes me wonder if
they’ll release an addon (or a patch) that puts Clippit back in.

10: February 2008

Microsoft Word

Do you have text in Word that you seem to do over and over again? Well, a
very easy feature to figure out in Word (any version up to 2003 and [possibly]
beyond) can help you out.

To use this feature, go to Tools>Macro>Record New Macro. Name it if
you want, then click Keyboard to assign your macro a keyboard shortcut.
Type a keystroke into the box. If it is assigned already, Word tells you. Press
Backspace and try again. When you are happy with your keyboard shortcut,
press OK. Click Assign, then Close. Your mouse cursor will have a tape
icon next to it and a small box marked Macro Recording will appear. Type
the text you want inserted. When you're done, click the square on the little
Macro Recording box. You can now press the keystroke to type your text.

Internet Explorer

If you've been following, you'll know that the little four squares icon to the
left of your tabs opens a thumbnail window. But what if you know what
tab you want but can’t find it? Click the little down arrow next to the four
squares. A dropdown list of your tabs will appear.

Firefox

If you're a Firefox user, you might often get annoyed with its slow loading
time. Much of the time, you just want to have a browser load fast and you
plan on closing it right away.

Anyone out there remember Netscape? Well, there’s a new incarnation
of that, now completely open-source. It’s called SeaMonkey. Download it at
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Windows Explorer

Rename your hard drive

Tired of going through life with a hard drive named “Local Disk”, “HP_PAVILION

(C)”, or something similar? Fix it with a simple menu option. Open Win-
dows Explorer to My Computer, right-click on your hard drive’s icon, and
choose Properties. On the General tab, change the name in the box.

General Windows

You've got a very important tip. (Cryptic Code #24111)!

Crazy Computers

Computers say nonsensical things

When I accidentally leave a floppy disk in the drive and I shut down,
the next morning I turn on my computer. I walk off to do something else
while the computer loads. Five minutes later I come back and face a black
screen with the words Non-System Disk Or Disk Error / Remove and Strike
Any Key When Ready. First of all, what is a Non-System Disk? And what
is a Disk Error? Turns out the Non-System Disk dates back to the days of
DOS 1.0, when some people kept their versions on a floppy disk and used
it to boot their computer. (Apple II, anyone?) If you had the wrong disk,
the computer would tell you. A Disk Error apparently means the disk is
corrupted.

Then Strike Any Key. (Want me to destroy your keyboard, anyone?)
Why can’t it just say Press Any Key, like anyone human? And why can’t
the computer, when it sees that the floppy disk drive has a Non-System Disk
In It, go looking in the CD drive and hard drive for an operating system?

1Sorry, I have no clue what the heck this was supposed to mean. I'm curious too.

9: January 2008

Note to Receivees

This newsletter will replace Windows Tips, which many of you will have
received. I decided it was time to fix up the whole setup, plus people always
like something new. If you read Windows Tips, you will find that this is very
similar, with the elimination of several features such as Crazy Computers.
Those features will hopefully soon be available through the Technical Geekery
website.

Microsoft Word

Heard about the new version of Word? Had enough with your version? Well,
you need to do some considering before you try it.

First of all, if you have Office XP (2002) or later, you aren’t going to get
much new. For a $150+ product (and that’s a cheaper price), it’s often not
worth it. Plus, you have to learn a new interface. Office 2007 now does not
have a menu bar. Instead, you must access all features from the 2-inch-thick
tabbed bar at the top called the ribbon.

Which brings us to the tip. The thing that Microsoft did do to help people
in transition was to include all of the old keyboard shortcuts. If you know
the system that’s been in Windows for hundreds of years (in computer time),
this could be a help. This system involves pushing Alt and then underlined
letters on the menu bar. Although you can no longer see the menus, you can
still use this shortcut.
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Windows Explorer

Faster use of Details view

Details view is great, but when there’s a filename or other data that doesn’t

fit into a column, it gets annoying. Next time you run into this, double-click

the right boundary of the column in question. It will automatically resize.
FYT: This also works with Excel.

General Windows

Lost the Show Desktop icon? Unfortunately, it is rather difficult to get back.
Pull up Notepad (Start > [All] Programs > Accessories > Notepad) and type
the following precisely:

[Shelll
Command=2
IconFile=explorer.exe,3

[Taskbar]
Command=ToggleDesktop

Now save the file as Show Desktop.scf and put it on your Quick Launch
toolbar. Hmm. . .looks a lot like your original icon!

Function Key Reference

These keys often go unused but are handy shortcuts

e F1 — Don’t you know? 99.9999999999999% of the time you can get
help by pressing F1.

o Alt + F4 — This keystroke closes the active program. If you are on
your desktop, it brings up Shut Down.

e 5 — This keystroke usually tells a program to go out to your hard
drive, the Web, etc. to get a new version. In Word, F5 brings up
Find/Replace/Go To.

Part 11

Technical Geekery Tips
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If you are playing one of the Windows games and your boss walks in:

press Esc to minimize it instantly. Note that this doesn’t work on all
of them.

Running an ancient DOS program with DOSBox or something similar
that runs fullscreen. You stuck in it? Hit Esc and see if it helps.

e If you start dragging a file and then change your mind, just
press Esc before you let go of the mouse button.

Crazy Computers

Crazy, means-nothing “Warnings” in Event Viewer
Event Properties Eﬂ

Event

Dete:  BISEO0E  Souce  W3RTime
Time:  33345AM Category: None
Type:  Waming  EventlD: 35
User  N/A

Computer: 5-SUPERCOMPUTER

EEE

Descriptior:

The lme service has nol been able to synchionize the system time for
49152 seconds because none of the fime providers has been able o
provide a usable ine stamp. The system clock is unsynchionized

Far mare informn:

. s2 Help and Support Center at
hitp://00 micioso!

omAwlink/events as

Wow! How awful! We couldn’t synchronize the clock in an astronomically
long 13 Hours! We're Unsynchronized!

Computers often display stupid messages like this when you look deeper.
Unfortunately, there’s really no way to get rid of them. You just have to deal
with it—and have a little laugh when something like this shows up.

OH NO! I'm Unsynchronized about a tenth of a millisecond!!!

39

The Clippit Column

Is Clippit staring blankly at you? Right-click him and choose Animate.
You’ll have to do it a few times, but there’s a bunch of cool ones.
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Back button. If you see a Latest Headlines button, it’s working. (If you've
installed a toolbar [or it came with your computer or another app| such as
Google or Yahoo, you may need to look under that.) To add something to
this toolbar, find the little icon to the left of the URL and drag it to the
toolbar.

Windows

What really changed in Vista?

This article will be slightly long this month, owing to the length of the
topic. Please feel free to skip parts of it if you don’t think they apply to
you, but if it interests you, I encourage you to read because you may learn
something new.

Below I will talk about what the changes are. 1 will explain all the
features, then supply another paragraph or two talking about differences
between versions.

Interface

Yes, the new “Aero” interface seems more like a marketing feature for people
who just go by looks. But it can truly be helpful to you. One thing is that
you can see under the title bar of any window. With certain windows, there
may be a larger transparent portion. (See Screenshot 2.)! Another lesser-
known fact is that you can see a preview of a window by hovering the mouse
over the taskbar button (Screenshot 3). Probably the most fancy feature that
Microsoft used for marketing is called Windows Flip. You've probably heard
of it. Use Screenshot 4 to confirm your suspicions. I like to call it “T'wirly
Window.” To get this, push Windows-Tab. Continue pushing Tab until the
window you want is in the front. The desktop is also a choice. If you can’t
figure out what a window is, you can try Alt-Tab, which also shows the name
of the window as well as a thumbnail preview. You may have to switch back
and forth. Alt-Tab is shown in Screenshot 5. (Incidentally, Alt-Tab with a
much less fancy interface was available in earlier versions of Windows back
to Windows 95.) As you can see, transparency is widely used in all these
features.

T left out the screenshots. If you'd like to see them, you can view the article online at
http://thetechnicalgeekery.com/windows/archives/tips_2008.03.pdf.

15: July 2008

Microsoft Word

Do you want to open a document in Word and save it as another file but are
afraid that you will accidentally save over the original? Here’s an easy way
to prevent you from doing this. Start Word and choose File>Open. Find
the file you want, then click the little teeny arrow next to the Open button.
(See below if you aren’t sure.) Then choose Open As Copy. You can then
save it with another name (if you remember!)

Internet Explorer

Although this feature isn’t as useful as it is in Firefox, IE can read RSS
feeds, a sort of news updater thingy that allows you to read current content
quickly. When you browse to an RSS-enabled website, Internet Explorer’s
“green wave” icon lights up. To subscribe, you can click it. When the
resulting web page loads, choose Subscribe To This Feed at the top of the
page. You can now view it on the Feeds tab in your Favorites Center (the
star in the upper-left corner of IE.)

Firefox

Well, you can also read RSS feeds, just like IE users. But Firefox’s way is a
little bit simpler, in my opinion. To subscribe to a feed, go to the site that
provides the feed. When browsing to a site that supports RSS, an icon exactly
like IE’s will appear. However, it will appear at the right of the address bar
instead. When clicked, Firefox will display a page showing the contents of
the RSS feed (well, not exactly, but you can think of it that way). Make
sure that Live Bookmarks is selected (it’s the default) and choose Subscribe
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Unlike with grouping, stacking, and sorting, you can filter by more than one
category. Filtering is done by clicking the drop-down arrow next to a column.
This arrow only appears when you mouse over the column. A filtered column
displays a check mark next to it. To learn about filtering, see Screenshots 9
and 10.

Grouping is like in Windows XP. To group, right-click the window and
choose Group By>Whatever Category You Want To Group By. If there’s
too much on the screen, you can click the little up arrow at the right of the
heading. See Screenshot 11 to learn about grouping.

Finally, stacking is basically a different way to use search. If you've ever
used Google Directory (http://directory.google.com) you know what I mean.
Great site, by the way. Stacking sorts all the files and folders in the current
folder and subfolders and provides them for you to pick one. It can be helpful
if you don’t want to group things but don’t want to use the search either.
It’s also just a cool new feature. See Screenshot 12 to get an example of
stacking. To view one of these searches (“folders”), just double-click it.

The other new feature of Windows Explorer saves copies of your files
and allows you to restore an old one if something goes haywire. This is not
available in all versions, but if you have it, it can be really useful. To access
these versions, open the Properties dialog box for the file by right-clicking
and choosing Properties. Then choose Previous Versions.

There are other improvements in Vista, but I am not trying to write a
book or even an essay on the topic. If you want to learn more about the
new features and basic functions of Vista, I highly recommend picking up a
copy of Windows Vista All-In-One Desk Reference for Dummies by Woody
Leonard. This book has been highly useful to me in making the transition
to Vista and learning about the differences.

Version Differences

This maybe shouldn’t come after a paragraph that seems to end this article,
but I figured it should be last. There are, unbelievably, eight versions of
Vista, and all of them are designed to make Microsoft money, save Microsoft
money, or stop a lawsuit. Don’t get tricked into buying the wrong one for
stupid reasons.

e Vista Home Basic is very cheap but doesn’t provide many features
that people like about Vista. Previous Versions, the Aero interface,
and several video tools are the main items left out.

14: June 2008

Microsoft Word

I am definitely not trying to advertise anything for Microsoft in this article,
especially since I don’t like Office 2007 myself. However, there is a very good
addition to the grammar check in this version. It is capable of spotting things
that it thinks should be said some other way but are correct, such as words
that are spelled correctly but don’t make sense in the context. If it finds
such a sentence, it gets a blue underline.

This tip was drawn to my attention by Jennifer Bjornstad, one of my
longtime readers.

Internet Explorer

If you don’t have a good mouse, or are bad at moving it precisely, this tip
may be useful to you. You can get the buttons on the toolbar to expand and
give you a larger target with only a very small waste of space on the area
that displays the website. Right-click on a blank part of the toolbar (to the
right of where the tabs are is a good place) and choose Use Large Icons.

Firefox

Have you ever been to a website that seems to have the teeniest text ever?
Yeah, me too. It used to drive me crazy, until I discovered that there’s a really
easy way to zoom on a webpage. Simply press the key combination Ctrl-+
to zoom in. You can repeat this as many times as necessary to make the
text readable. If you really don’t like the keyboard or have your hand on the
mouse and are willing to move it a long way, you can also choose View>Text
Size>Increase. To return to normal size, push Ctrl-0. Note: Because of the
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13: May 2008

Internet Explorer

If you upgraded to IE 7, you might have trouble figuring out how to save
pages. Ctrl-S doesn’t work, and it is difficult to find the menu bar, especially
in Vista. (Incidentally, if you know where something is on the menus, you
can tap the Alt key to see them temporarily.) The new Microsoft-approved
way to save a webpage is to click the big Page button on the right side of
IE’s toolbar. Then choose Save As.

Firefox

I discovered this trick to be a great time-saver, a great time-waster, and a
great way to make things totally sloppy if you don’t clean up. If you use it
properly, it will do nothing but save time. If you are sloppy, it will cause you
to wait for about ten times the time it normally takes to load Firefox.
Anyway, this trick automatically saves all your open tabs when you close
Firefox. It will waste your time if you don’t ever bother closing tabs, however.
If you don’t think you will be disciplined enough to do it, this trick WILL
SLOW YOU DOWN. Anyway, to do it, simply choose Tools>Options. Select
the Main tab if it isn’t already, then at the top where it says Startup > When
Firefox Starts, select Show My Windows And Tabs From Last Time.

General Internet

T was a user of Yahoo Mail for nearly six years, and I always thought it was
great, especially after they added an interface that allowed you to drag stuff
around, show stuff in a preview pane, etc. But when Google announced that
Gmail was available to the public, I decided I might as well try it. After
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of the Word window.

If you accidentally delete the Add to Work Menu item, shoot me an email
at soren.bjornstad@gmail.com. I hope it won’t happen to anyone, and I
don’t want to try it myself unless it’s necessary.

Internet Explorer

Have you noticed the little box next to the Address bar that says Google (or
Yahoo or Ask or Joe Bob’s Evil Flying Pig Finderer Discoverer Searchery
Thingy Search, depending on who paid your computer manufacturer) in it?
You can type in this box to search that place. For people who like keyboard
shortcuts, you can use Ctrl-E. (No, I don’t know why E stands for “Search.”)
Changing the provider is easy too, at least if you want to switch it to a
common provider. Click the little black arrow next to the magnifying glass
icon that sits in the Search box and choose your preferred provider.

Firefox

Do you notice those little lines in your Bookmarks list that look so fancy
and professional? Intended to divide different sets of bookmarks, these don’t
seem very easy to make. However, it’s surprisingly easy. Simply right-click
the entry below where you want the separator and choose Add Separator.

Windows Vista Report

Last month there was a report on what changed in Vista. Several months
ago there was a report advising you not to buy Vista by itself because it
wasn’t worth it. I still completely agree with this. I finally came up with a
simple set of rules.

o If Windows XP is still working just fine, there’s certainly no reason to
buy Vista.

o Unless you can'’t live without one of the following features, you're better
off staying with your old computer:

— Instant search in the Start menu

— Better backup and data recovery features

— Better sort in Windows Explorer

e If you aren’t a business, go with Vista Home Premium. Geeky types
might be tempted to buy Ultimate, but it isn’t worth another hundred
dollars.

o DON'T buy Vista Home Basic unless it’s not for your main computer.
You'll regret it for a long time.

Prize coming. ..

One free email address, yourname@thetechnicalgeekery.com being given
away! All you need to do is find the formatting difference between two parts
of this document. They may even look the same...And no, it isn’t bullets,
bold, italics, underline, tabs, etc. First person to send an email to me with
the correct answer wins the address and configuration. It can be set to
automatically forward to another email account, too.

Announcements

What program do you not see on here that you use? Come on, you know
there are some. If T get the same program from at least two customers and
I know something about it, I will include it on the next newsletter. Do
you have any friends who you think would like this newsletter? Have them
send me an email at soren.bjornstad@gmail.com and ask to be added to my
mailing list. If you wish to unsubscribe, you can click the link in my email.
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name. The & sign simply makes the next letter underlined, which allows
you to move to it by pressing Alt and then the underlined letter. If there is
another one with the same underlined letter (such as on a menu) then you
can toggle between them and press Enter when you reach the correct one.

When you are done with your customizations, drag the toolbar to its
final place. This can be at the top or bottom (or even in the middle of the
document or on the side). Then close the Customize dialog box. If you ever
want to modify the toolbar, simply click the little down arrow pointed to by
the arrow on the page (yes, confusing.) Then choose Add or Remove Buttons
> Customize. You will end up with the dialog box you were using earlier
and can right-click commands or drag new ones on.

Internet Explorer

You can change the search provider where IE goes when you type something
into the search box at the right of the address bar. Simply click the arrow to
the right of the magnifying glass and choose which one you want. For even
more, choose Find More Providers.

Firefox

Get Firefox 3 at www.firefox.com.

Windows

It may be that nobody has ever even thought about this, but having your
Windows version displayed in the corner of your desktop can be handy. This
tweak also displays the “Build” which is occasionally useful technical infor-
mation. It also looks a bit geeky, so don’t be surprised. This tweak seems
a little bit odd, but it is also quite simple and not dangerous compared to
other ways of getting this done.

To begin, start Notepad, which is usually under Start > All Programs >
Accessories > Notepad. If you can’t find it, simply press Windows (the flag
key) + R. Then type ‘notepad’ (without the single quotes) and push Enter.
Type the following into Notepad:

Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Control Panel\Desktop]
"PaintDesktopVersion"=dword:00000001

Part 111

Technical Geekery Blog
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75

just right-click on an empty section. If you want to get rid of it, just choose
Close Toolbar from the right-click menu.
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few seconds. Simply right-click the folder and choose Properties. Click the
Customize tab at the top and choose Change Icon. You have a good number
of icons displayed immediately, but you can get even more. Try typing the
following into the Look For Icons In This File box at the top:

Shell32.d11 (default)

Moricons.dll (old programs, especially notable for the great file cabinet
picture toward the end of the listing)

e Progman.exe (XP ONLY, all sorts of stuff)

e Syncui.dll (folders)
o Pifmgr.dll (brightly colored household objects)
e User32.dll (error, info, ete. icons as displayed throughout Windows)

o Explorer.exe (seemingly random)

e Dialer.exe (phones)

Regedit.exe (weird cubes)

Taskmgr.exe (variously filled status bar-thingies)

bthprops.cpl (possibly Vista only, random again)

20: December 2008

Microsoft Word

If you're unlucky enough to still have a version with Clippy enabled, here’s
two easy ways to zap the annoyance once and for all. (Note: if you have Office
2007, Microsoft finally removed Clippy completely and spared Windows users
the world over the annoyance. I just wish they had quit when they were
ahead: what’s up with the menuless design?)

If you're like me and sometimes enjoy watching Clippy do weird anima-
tions or something similar but absolutely detest annoying popups like “It
looks like you're writing a letter”, try this fix. Choose Help — Show the Of-
fice Assistant if Clippy isn’t currently showing. Now right-click and choose
Options. Uncheck every box except “Use the Office Assistant”. This will
prevent Clippy from appearing except when choosing “Show the Office As-
sistant” from the Help menu so you can decide for yourself if you want to
give Clippy the privilege of appearing on your screen.

If what you want is a completely Clippy-free Word, just unchecking “Use
the Office Assistant” isn’t enough. If you or anyone else clicks “Show the
Office Assistant,” Clippy is re-enabled (yes, the box is checked again). Com-
pletely sending Clippy back to the bit bucket from whence he came requires
a more permanent solution. Choose Start — Run and type appwiz.cpl. This
shortcut is an easy way to access Add/Remove Programs (or, as Microsoft
calls it in Vista, “Programs and Features — Uninstall or Change a Pro-
gram”). Find Office in the list and hit whichever option includes “Change.”
In the resulting wizard, check “Choose Advanced Customization of Pro-
grams” or something similar. (Different versions will no doubt be slightly
different.) Click the plus next to “Office Shared Features” and click the hard
drive icon by “Office Assistant.” Choose “Not Available.” Now click through
the rest of the wizard and Clippy ought to be gone for good. That is, unless
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e Windows-F [opens a Find window]

Windows-E [starts Windows Explorer centered on My Computer]

Windows-D [minimizes everything, press again to go back]

M to go back]

Windows-Break (yes, that’s a key, look for it) [opens the System Prop-
erties dialog box]

General Windows

Have you ever been in need of some background music say, for a presentation?
Were you on a computer without any music on it? Well, every Windows XP
or later computer has three quite good background music MIDI files on it,
which can be opened in Windows Media Player. Simply choose Start >
Run and type C:\Windows\Media. The three files are called flourish.mid,
onestop.mid, and town.mid. The best way to get a feel for them is simply to
try them out sometime and see what they’re like.

Windows-M [minimizes all windows except dialog boxes, press WindowsShift-

19: November 2008

Microsoft Word

Did you just type a couple of sentences with Caps Lock on accidentally?
Guess what—you don’t have to type it all over again. Just remember the
magic shortcut Shift-F3: push it to toggle between UPPERCASE, lowercase,
and Title Case. If you want to prevent the problem from happening at all,
see Keyboard Shortcuts this month.

Firefox

Want to get lots of fun but useless (okay, maybe a few useful) add-ons for
Firefox? Simply open Firefox. In the following directions, you may need to
replace the word “extensions” with “add-ons” depending on your version of
Firefox. Choose Tools — Extensions, then in the corner click the Get More
Extensions link and browse the resulting site for handy or useless gadgets.

Google Chrome

Google released a browser. How can anyone not have heard about it? Google
Chrome offers some pretty interesting new features and runs and loads very
quickly. Beware about running Flash animations and games, though: Google
Chrome doesn’t run very fast on them, although the Googlies are working
on it, so it will hopefully be revised soon.!

Go to http://www.google.com/chrome to download your free copy.

1Lately I haven’t seen any problems with this anymore.
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80 21. TEN WAYS TO KEEP YOUR PASSWORDS SAFE

you need to be cautious. Every person that knows a password multiplies
the risk of having it stolen or social-engineered (more on that later). Just
because you trust someone completely doesn’t mean that they will keep your
password with the most care possible. If you need to share your password
with someone, make sure you know for sure that they will not write it down
or save it and that they are smart about social engineering.

If for some reason you need to share a password with someone you don’t
know much about, you can always change your password temporarily and
then change it back later.

2. Shoulder surfing

Although it sounds like one of those stupid things people try to do at rock
concerts, it’s almost undoubtedly the oldest and most low-tech way to steal
a password. All you have to do is get behind someone and watch them enter
their password.

Since passwords were developed, login screens have hidden the typed
characters in password fields from view to make shoulder surfing much more
difficult. However, someone who gets lucky, has sharp eyes, or tries multiple
times will have a fairly good chance of getting your password by looking at
the keyboard. Since most people use the same password multiple times (hey,
even me, and I'm writing about security here), stealing one password will
allow them to get into multiple accounts. (And by the way, this problem isn’t
limited to computer terminals; you should always cover the PIN pad with
your hand when entering numbers at an ATM or store checkout. Besides the
chance of someone walking behind you and spotting your number, crackers
have been known to place cameras aimed at the PIN pads to catch unwary
users. )

Obviously, if your computer is placed in a closed room, it’s going to
be pretty hard for someone to sneak in behind you and shoulder-surf your
password without you noticing. However, be careful if you invite someone
you don’t trust into this area; shoulder surfing is one of the things people
tend not to think about. If your computer is easily visible, especially in a
crowded and noisy area, you have a much bigger problem. Not only are you
less likely to notice someone sneaking up behind you, people will also feel
much more confident and are more likely to try to steal your password.

There are a few things you can do to try to prevent your password from
being shoulder-surfed. There are two parts to successfully stealing a pass-

23: Installing Windows

Microsoft and many people on the Web are claiming that Windows can now
be installed by a novice computer user. After installing on my computer,
I thought that installation had certainly come a long way. But after my
experience helping another user install on his computer, I beg to differ.

Our plan was to back up everything, take some Windows settings with
Windows Easy Transfer (a program for moving settings and files to a new or
freshly installed computer), wipe the hard drive, and create two partitions:
one for data and one for the system files. Fairly standard procedure. (For
those of you who don’t know, a partition is just a section on a hard drive that
appears as a separate drive, allowing you to, in effect, split one physical drive
into multiple drives.) So we backed up, put the CD in the drive, restarted,
and got into the partitioner. We set things up as planned, then moved on
with the installation, which was amazingly simple, elegant, and fast.

Then we got into Windows for the first time after waiting about 20 min-
utes for copying files. It looked great until I realized that we had selected the
data partition as the system partition and vice versa (one was significantly
larger than the other). Oh, well, haven’t done much yet, so just re-install.
But it would have been nice if the installer had been clearer, because once
you're done partitioning, you would naturally hit “Next” in the installer.
The only hint that it wasn’t quite so simple was the title, “Select the drive
you want to install Windows on,” indicating that the entry you had selected
when you hit Next would select the system drive. It would have been much
better to open a second dialog box if you wanted to modify the partitions,
and not provide a way to change partitions from the selection window. Mi-
nor bad design there; a novice user would probably not have changed the
partition table, though, and thus would not have hit this problem, so I can’t
really cite this as part of my argument.

Once this worked, we opened Registry Editor and told it to put the
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your passwords securely so you only have to remember one (strong) master
password or plug in a flash drive and unlock all your passwords. After a
timeout, when you log out or lock the file (when you leave the computer,
hopefully), or when you remove your flash drive, the file that stores your
password is unloaded and becomes inaccessible. This will also allow you to
more easily use stronger and different passwords.

4. Security vulnerabilities

No program of any significant size is safe from bugs. Matter of fact, no pro-
gram is safe from bugs. So it follows logically that most major programs have,
at some point, suffered from security vulnerabilities. This is not a problem
in itself; the problem is that people often fail to patch these vulnerabilities in
a timely manner. Nearly all security holes are patched well before they are
successfully exploited, so as long as you pay attention, you have very little
to worry about.

In terms of passwords, there are relatively few exploits of this sort, but it’s
always a good idea to keep everything up to date. Make sure automatic check-
for-updates features are turned on, update to the latest versions of programs
periodically, and keep a lookout for any published security advisories.

5. Database cracking

Database cracking is one of the most dangerous threats today. In database
cracking (which isn’t an official name, but it works, and I don’t think there is
an official name), a cracker or group of crackers breaks into a large database
kept by a company on a secure server and steals all the information on it,
which can be worth huge amounts of money. Database cracking is more
commonly talked about in terms of identity theft, but it is also an easy way
to steal emails, passwords (they are part of your identity, after all), and more.

Unfortunately, there’s very little you can do about database cracking; you
just have to trust that everyone you give your information to will do their
best to keep it secure.

6. Guess the password

Since too many people use simple passwords, a cracker has a decent chance
of being able to sit down in front of a computer or login page and guess the
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before deciding what I'm going to write, then input it. If the computer is
just trying to turn my thoughts into words, will it just place random words
that are going through my mind on the screen? Will it know when I'm just
paused to collect my thoughts and enter completely unrelated things?

Also, we're used to having to do something to have something happen.
It would not be a particularly easy transition. People might turn away to do
something else and not realize that they hadn’t turned it off and strange stuff
would be happening on the computer. Perhaps having some sort of dummy
device would be helpful (say, a mouse that didn’t do anything). Would you
be able to reliably think about where you wanted the mouse pointer, and
once again, would it be able to tell the difference between considering and
actually wanting to click somewhere?

Conclusion

I'm sure there are many other things you can think of; these were just my first
thoughts. Feel free to add your thoughts by clicking on the “Comments” link;
if there’s something good, I may add it to here. And by the way, I noticed
that I have overused semicolons in this conclusion; they are quite useful,
though.
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84 21. TEN WAYS TO KEEP YOUR PASSWORDS SAFE

e Does not include many sequential numbers or letters, letters contiguous
on the keyboard, or a combination of the two.

e [s not a common English word.

Also see the “Guess the password” section for more guidelines.

8. Brute-force

A brute-force attack consists of trying every possible password until the right
one is found. No matter what security measures are used, a brute-force attack
is guaranteed to eventually come up with the right answer. However, a brute-
force attack takes a really long time (unless it gets lucky); if you have a strong
password, it could take centuries to crack it using powerful computers.

To combat brute-force attacks, make sure you have a strong password,
using the password guidelines for #6 and #7.

9. Keylogging

A keylogger is a program or hardware device that stores all the keystrokes
entered into a computer. Someone can install a keylogger, then later come
back to retrieve the data collected, search through it for sequences that look
like passwords, then attempt those passwords.

To protect yourself against software keyloggers, make sure you have an
anti-malware program that includes spyware protection installed and that
it scans regularly. To protect yourself from hardware keyloggers, make sure
strangers cannot easily access where your keyboard plugs in, and check oc-
casionally to make sure there are no odd devices plugged into the system
(keyloggers are usually plugged in between the keyboard and the computer).

10. Social engineering

Social engineering (in a security context) is simply the process of trying to
trick someone into revealing confidential information or doing something that
will compromise the security of a system (like disabling security measures).
Social engineering is rarely attempted in person, but there’s no reason why it
cannot be. One of the reasons why it is so successful is that, in many cases,
it is not actually a crime, so even if the attacker is caught, they cannot be
arrested. The person has chosen to give the information, after all.
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neck to look down. Either way, there’s that nasty problem of blocking your
view of the screen with your fingers.

Option 2: Voice Recognition

Voice recognition seems like a great idea on the surface. You don’t have to
learn to type or use a mouse, and you can just tell the computer what to do
instead. You can easily dictate documents, too, and most people can speak
faster than they can type, so that works better.

In reality, it’s not that great. First of all, voice recognition only has a
stated 99% accuracy, and in many cases, it’s a bit less than that. The errors
are not intolerable, but they are certainly annoying. In actuality, the number
of errors is less than most people make while typing, but typing errors can be
corrected in less than a second by fast typists. Voice errors take a long time
to fix; you either have to reach for the keyboard and fix it or go through the
laborious process of scrolling to the word and reading it out to be selected
(and if it doesn’t recognize that word, you might have a hard time selecting
it) and then hope that it recognizes the word the second time around. Most
good packages can “learn” and thus have less errors over time, but our voices
are so complex that a computer has a hard time understanding what would
be simple to us.

However, if we decided voice recognition was the way to go, we could work
hard on the technology and greatly improve the accuracy, which is getting
better all the time. Unfortunately, that’s not the extent of the problems.
First of all, there’s the issue that speaking makes noise. If you're in an office
environment without closed doors, not only will loads of people be distracted
by what other people are doing, there’s a chance that the software might get
confused too. Also, people like the fact that others can’t tell what they're
typing. It would be hard to do something even semi-privately in a crowded
area using voice recognition. Next, there’s the fact that it’s much harder
to erase large blocks of text. If you type a sentence that doesn’t work, you
can just backspace it in a couple of seconds or even correct it in places using
your arrow keys. Correcting text takes forever, because it’s not easy to speak
about appearances. I'm going to reference a Science Olympiad event called
“Write It Do It” here. In this event, you get something built out of Legos or
Tinkertoys, and you have 25 minutes to write directions for your teammate.
Then he has to try to build an exact replica with only your directions. The
same basic problem exists here. It’s much simpler to point and click at the



)1 pustrodal A3y T ‘o1do) sIy) Ul pajseIaqul [[e je
21,104 JT 31 yuesaid 0y op (09 £17) wed nok jeym pue ojdoad [00] S199UISUL [RIDOS MOY UO
spuedxo YoM ‘(109UISUD [RID0S IOULIOJ ®) MOTUIN WA Aq fiprinoag [o pudwa)s uvwnpy
oy bugjoapuoy) uoydada(g fo 14y oy, POIed 0o SutuepySIue A10A © prar A[JUed0l Iy

-o001d uat0)s weaq sey piomssed APy, © mO[[0] 10 Auedwod o1} YIM [ONO}
ur jor) )1 1040001 0 jdwegje ‘promssed o1) poSuetp Sey IoyorId o1} I
“Aesye 9T MOIT) pUe 1097S pIomssed o1} PaIys 10 WIN( UAT[Y
‘W) IqUIdWDI 0) SUI0S § uaIe NoA Ji Iefeuewr piomssed e Ul W) 010)§
‘(eImyny oY) U SIY) PIOA® 0} JUSISYIP WY} JO SWOS Jses] Je Junyew A[nJ
-odo1) Aftrerodmwe) UMOp W) 9JLIA\ "US[0)S WA Sey| Je[) plomssed o1y asn
YR} SUIS0[ I9J0 pue sojIsqom [[e 10] spromssed moA ofueyd o8 Afpjerpowrua]

uo[0)s 1938 paomssed Inok Iy

Koot
10 UOTJRULIOJUI 9I0UI [€9)S PU®R NOA djenosiodl 0} YSNOUS 9ARY UOOS PINOd
Aoy ‘owury ' Je 91( SUO ‘UOIJRULIOJUI snondouul Ajjueredde y8nous siejed
QUOLAWIOS J] "1 I0] [IRWID PUR ‘SSOIPPe ‘OuIRU INOA MOUY 0} PIau 3,U0pP A}
mq ‘ouy ‘AeAIns ® aye) 01 NOA juwem Aoy} J] "1 9AIS 0F J0U 1S9 S 91 ‘TOIyeU
-IOJUT INOA I0J SYSe PUR NOA S[[RD 19A8 MOUY },UOP NOA SUOSWOS JT ‘A[[eut
91 Surpues A[pasoddns sem jer]) uorpeziuedio oy 0} ) 110dal ‘) 19)30( 10
‘A[ojeIpatIUI [TeW® o1} JP9[o(] "JUNODIR INOA JNOR UOIRULIOJUT WIS[) [Teulo
01 NOA NSt I0AD [[IM )R} 9)IS(om IO UOIjezIuesIo 9)etIISo] o[SUIs ® J0U ST
QIoY], ‘[RWd AQ UOIJRULIOUI [RIIUSPYUOD 10 pIomssed INOA PUSS I9AdN
[ WYY quasaxdal
07 SUIAI) Sem OUOIUIOS R} MOUY 0} POISAIUI AToA oq [[,A01) ‘A[oNI[ ISOIN
(e1qrssod JT) JIPSINOA 9101} SALIP 10 (M ‘)94 19939 *J1 10] pay[se A1} JT wor[)
3[Se PUR ‘9)RINDOR 9 0} MOUY NOA SSAIPPR/ToquInu © 1M JesimoA uosiod o1
[rews 10 [[ed ‘[rews oY) o#s0[d 10 suoyd o) dn Suey ‘uoryewniojur jo 9derd v
MOUY] 0} SPasUl A[[Rel SUOSWOS ISJoyM JNoge J(NOp Aue IeAd S2I8U) JT
‘promssed IMOA MOUY 0) POJU J0U S9OP JUNOIR [BJARJ INOA UL 97°QLETTITS
nsodep 01 syuem oym uejstueysyy ur Ang ojrjod Af[esr jey, AemAue ual[)
[pun ur So[ 0} d[qe 9 J,u0M NOA pue ‘pPaxy 1 198 0} sjUSWOTURIIR ONeUT
[LAo) ‘yseld aseqejep e sem A[[eal aloy) J] ° SRID aseqriRp, ® JO oSN
plomssed IMOA MOUY 0} SpodU 10Ad APOoqoN ‘plomssed INOA mouy o) posu
j0U $00p I PouDJ -os[e osuofue 0} piomssed IMOA 0AIS IoAdU ‘[[B JO )SII]
qutod owos je NOK 0} 1 Op 0) AI} [[IM SUODWOS Jer) APNI[ ST 91 Jey) j0v]
oY) JO oIeme 9 PINOYS NOA ‘SULIPUISUS [RIDOS WOI] J[osSIMOA 309301d OF,

a8

INOA UrRI)s 0} 9ARY NOA UL ‘Ysop INOA WO usaI1ds o) Suroe[d Aq jer) oA[0s
0} aIom NOA J] "WAT) 8sN 0} NOA JO JUOTJ UL JNO AvM [[ORAI 0) dARY NOA 9sned
-9( 9ST 0} J[RIIOJUIOIUN ATI9A IR SUSDIIS-TONO) [RUOTJUIATION ‘A[0JRUN)IONU)
*(pnog-1ymu syroddns uesrds mok Surmsse) 03 01 Juem NoA Lem IPIYM U0
poseq 91 yourd pue ULIdS d1[) U0 S1FUY om) Jnd JSnf jWO0Z 0) JURA\ OIS
SOAOTI I0SIND A} PUR ‘U0eIds oY) uo 9oe[d © [PNOT, 108 Wed NOA se dAIY
-NUT Sk JNO(R dIv PUR ‘S[OAD] AURW UO 9sUdS Jo Ajuo[d oyRul SUOIDS UONO]T,

uoaI9s yonoy, :T uorpdQ

‘ste]qoId DTOU0319 9)eaID
0} pue} Ad1]) pue juendge A[30eyed jou o1 Aoy) geryy st wojqold o], ‘[[om
A7300710d sx{I0M ST} puy “peasur pedLoy ouodo[e) 10 PIROADY-TUII pUE
TUSIINS-TON0) B 9T JYSTW A1) ‘901ASD S[I(OUL © 1M FuIsI0M o1 401} JT “1oind
-TI0D IO} TJTM JI0M 0 9SO pue preoq4ay e asn a[doad jsomr ‘Ajyuormy)
"s10110 pure poads UoaM)O( dOTIRTR]
JYSBLI 9} PUY 0} AR NOA ‘DUIT) 81 JO ISOUWL JN¢ ‘PojURIIEM ST UOIINRD SUWOS
‘auopun a( joutred Jer) SUIYoWOs Op 0} IMOge 9INOA JI ‘A[SNOIAG() TOIIN(
AToAs BUBPI 2I10Jo( ¥0ayp-o[dL1) pue Apesajs puey INOA PO 0} dARY P[HOM
noA ‘woing SuoIm oY) DI IeAdU 0f PRY NOA JT "IXe) mou Surdey A[[enjoe
op £o1) sk SIOLI® SUIXY oW} [PNW sk Jjer) puads A9} ey} 901)0U UdAS JOU
pue ‘U0 08 ‘W) spr Ad1[) sk jse] sk gsul wet) eorvdsypeq Ajdus pue s10119
oyewr [ Aoty yeryy jovj oy jdecoe Afdumrs s3stdL) 4SO\ “OSIMIOYIO TDRAI
Pmod noA peads o1} jo 1elrenb-suo jnoqe je adA) pnom nok ‘FurdL) ueym
19999 ® AOYSIWT I0AQU O} PajuRM TOA J] pajeIssniy A[[eal 108 0} jre)s ajdoad
pue Aueur 00} nq ‘S9AI o YSnoayy o3 0y a[qissodwur A[Tesu o¢ pmom 1 10
s10110 owros 3dodor 0} oART 9A\ “jueM A[[edI 9, UPIP NOA Suryjowios SuiAng 10
o[y o[qeaoe[darir we Surjaap oyl ‘dn 1olewr Suryjewios maIds Aferyusjod pmod
pue ‘91 Surgoe1100 oty pueds 01 SARY NOA ‘10110 U S 210} USYA) ;AN MoI10s
0} JUIYDRW B[} 10 NOA oIk A[OYI[ MOH ‘SIOLIS JO UOIsenDh o1} OS[® S 011 ],
‘owr) AU [)Iom
J0U S,31 ‘91 SUNLIM-PURY URT) IOMO[S ST 90IAP ® OJUl SUN[IOUWOS SULIDIUS JT
‘A[[eIouor) 9[PPIW O} UL dIYMIUWOS $omod puey Aq Suntipy Af1ood A1oa op
‘SOOTADD O[IOW AURT 00} ARM TO dUWOD JRI[} SPIROADY AUT) O[)41] 9SO JuIsn
pue ‘siojernores Surydelsd wo 9xo) SuLLUS ‘SUIIXO) ONI[ ‘SIOYI() [[oM A[Ire]
op ued ‘uoryiudoosal yooads pue SutdA) ox1] ‘serdo[oute) dWOG ¢TI Ry} 0}
198 noA weo aso[ moy “ndut ynoqe Jurre) uoym purwr ur deoy oy sSury) oy
JO 8UO ST INq ‘OqeAfosun A[esiseq st wo[qold SIJ, "9d1)0U 0} JOU SOA[ISINO

SAOHLHAN LNdINI ¢C 88



86 21. TEN WAYS TO KEEP YOUR PASSWORDS SAFE

dure. On many sites, like Gmail, you can fill out a long form telling about
your emailing habits, then the Google staff checks it against the logs and can
often give you your account back. Of course, in the meantime your email
may have been read, information stolen from it, and deleted, but at least you
have your account back. If you think any other passwords may have been
compromised by this account being taken over, go change them too.

Conclusion

I hope to have included most of the ways that passwords get taken. Read
it, make sure you follow all the guidelines, fix a few things if you haven’t,
then go on with your life knowing you’re that much more secure than other
people. Remember: There’s no way to stop the crackers, only slow them
down and hope for the best.

22: Input Methods

I don’t actually remember learning to use a mouse. Ever since I can remem-
ber, I've just been able to click on what I want and move the mouse where I
want. But when you think about it, the mouse isn’t actually the most intu-
itive input device. You move it sort of where you want the cursor to go, but
the direction and distance doesn’t really match the action of the cursor on
the screen. And most people are temporarily confused when learning about
computers for the first time by the fact that you can pick up the mouse
and move it to a completely new location without changing what’s on the
screen at all. Furthermore, you click over a certain location when you want
to activate something. But you have left-click, right-click, and zillions more
options to choose from. And sometimes you don’t actually click to select
something. We have learned to use mice and done so much work with them
that it requires no conscious effort to do something on the screen.

I do remember learning how to type properly, though. I went through
multiple programs and did lots of practice on my own, and by the time I
reached sixth grade I could type about 60 words per minute. The problem
is, after three more years of keyboarding, I have barely improved at all,
because I had already nearly reached the upper limit of how fast my fingers
could go. This is a major limit to typing, but as I will talk about later, it
still has certain features that no other current technology can offer.

We (and I am often guilty of this) frequently talk about being able to
input or write something “as fast as you can think.” And it’s true that you
can only think so fast. For instance, before I started writing this sentence, I
stopped typing for a few seconds to get my thoughts together about where
this post was going. But when you get a thought about something you're
trying to write, you are still limited by the speed that you can type it.
For that matter, the same thing happens when speaking. It’s just that it
seems much more natural for some reason, and that we’ve somehow trained
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96 24. PERSONAL INFORMATION ON THE INTERNET

more specific stuff, but no luck.

At this point, though, I have many other names. Chances are that if I
look them up, I'll get some contact information, and I can probably trick one
of them into giving me, say, my email or phone number (perhaps I have an
opportunity for me to play violin for something, or to participate in Science
Olympiad camp). (I didn’t try that, since it would take time, and I didn’t
feel like purposefully fooling people I knew, plus there would be a pretty
good chance they would recognize my voice). Let’s try that. With my phone
number (which won’t be too hard to get) I type it into Google, and—huh,
there’s my address and parents’ names.

I should also mention that, not having any major legal documentation
yet, my name doesn’t appear in many directories. Try searching on yourself.
It may be rather enlightening.

28: SimCity, Random Failures,
and the Core i7

These don’t seem to go together, do they? In fact, if you think the title makes
sense, you're lying, crazy, or you've been following what I've been doing the
past couple of days.

Everything started when I woke up on Monday, my first day of spring
break. I slept until about 8:30, woke up, and figured I'd check my email
and maybe read the news before breakfast. I walked over to my computer,
which was in standby, hit the power button, and...nothing came up. The
fans started, but the monitor stayed in power-save. Thinking nothing of it,
I rebooted.

Guess what? The monitor still stayed in power-save mode. Okay, suppose
the monitor’s bad. Or maybe the cable; the last time the screen was all
green, I unrationally suspected the graphics card and bought a new one
before I realized the cable had died. But my second monitor wasn’t picking
the signal up either. So I walked down the stairs, grabbed our 21-inch TV,
which has a standard computer input, lugged it up, and plugged it in. Power
back on. Nothing.

I started thinking, “Hmm, what have I changed that might have caused
this?” Thing is, I hadn’t installed or changed anything. I had recently in-
stalled a sound card, but that was about a week before, and it had worked
flawlessly up until then. No, it seemed to point toward some sort of random
hardware failure.

I guess the graphics card has to be bad, right? Pull out the graphics card
and plug into the graphics built into the motherboard. No luck there either.
Maybe the settings are still set to use the nonexistant graphics card? Reset
the BIOS settings. No luck.

The computer didn’t seem to be POSTing (passing the power-on self
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98 25. TECH SUPPORT

us. After explaining the problem, the rep had us download software that let
her access the computer remotely, then proceeded to check that the volume
was up. After this, we got transferred no less than four times, often without
doing more than explaining the issue. The best part, however, was when one
of the reps said, “Well, if you want to hear sound from your tape recorder,
you should just hook it up to the speakers.”

The next day, we got back on the phone, and after another two hours
of being transferred, and a time when we were on hold and they were doing
things remotely on the computer without our consent, we finally gave up,
went to Best Buy, and bought a new sound card, which worked perfectly. But
afterwards, I realized that we actually knew more than tech support, after
just a little bit of experimenting and searching Google. It’s just pathetic,
and what a waste of four hours.

Another time that was even worse was when I bought a new computer
in 2005. It was an HP (a brand which I have since decided to avoid if there
is an easy choice), and at first, it felt great, coming from a Windows ME
computer with a 900Mhz Pentium and 64MB of RAM. But after about a
month, I started to notice weird things: the computer rebooted randomly
with Blue Screens of Death, I got messages (related to that) that said “The
system has recovered from a serious error” on startup, the NumLock key

wasn’t working right, and when I put programs full-screen, the screen would
go black when I exited, and I would have to put it in standby mode and come
out again to fix it.

I called tech support a few times about this, and none of it actually
worked. Finally I got sick of the full-screen problem, and after I had called
about something else, when the rep asked, “Is there anything else we can
help you with today?”, I told him about that problem. I was told that it
“was a problem with the operating system” and that I would have to reinstall
Windows. So I did. However, once it was done, the problems were worse
than before. I tried completely reformatting the hard drive and reinstalling
again, and had no more luck. So I called again, and, after about an hour and
a half, finally made it to someone who agreed to let me ship it in for repair.

When it came back from repair, I was told that they had found a problem
with the real-time clock and that it had been fixed. Nope, same errors, and
to add insult to injury, the system didn’t turn on, and we had to actually
tape the power wires somewhere to get it to turn on (I suspect it was a loose
connection). I had it sent in for repair again, and they replaced the hard
drive. Same errors. Finally they shipped out a completely new system. It
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already exist. The simplest way, therefore, to get any such system to work
would be to simply include the necessary software and logic on all new phones,
and after some period of time (say, 7 years), all phones that were purchased
before that time would simply cease to work (after sufficient warning from
the provider, of course), and the rest of the system could be implemented.

Point 7: Conclusion

Naturally, I have no leverage whatsoever to get something like this working,.
It’s a very ambitious concept, and I have severe doubts that our society will
welcome anything like this. Maybe you don’t agree with me on all the points;
maybe you don’t even agree that something like this is necessary. The thing
to remember is that having phones ringing during performances and at other
inappropriate times is extremely annoying, and that people have a tendency
to try to use phones when it is not reasonable to do so. If we can’t trust
people to take care of this themselves (and it seems that we can’t, from the
past few years), I see no other real solution than to implement some kind of
control. I don’t even trust myself to always turn off my phone at the right
times (and I'm writing this)—more than once, I've discovered I've left my
phone on during school, or an equally bad time.
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100 25. TECH SUPPORT

gether myself to save a few dollars, and I'd much prefer to know that what
doesn’t work is my fault and figure it out myself, especially since I'm fairly
confident in my ability to do it right.
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in testing environments. For instance, when I recently went to take
the SAT, people were discouraged from bringing phones in, and anyone
whose phone went off during the test would be dismissed and have
their scores canceled. For me, I needed my phone to call for a ride
home when the test was done, so I resorted to removing the battery
and placing both the battery and the phone in my bag. Having this
mode would remove the problem completely.

Point 3: Emergency Use

I can just see the people who are opposed to this sort of control going, “But
what if there’s an emergency?”

e An emergency switch would be located inside the battery compart-
ment of each phone (to prevent accidentally triggering it). Turning
the switch would allow the phone to pass through the communications
and phone blocked modes (after answering a question on the screen as
extra confirmation). To prevent abuse, the phone would immediately
and automatically connect you to 911.

The control box, which would be located in a public place, would have
an emergency lever that would call 911 and activate emergency mode.

Emergency mode would be triggered by turning the switch on one’s
phone or by pulling the lever that would be situated on the control
box. Emergency mode would have the following effects:

— The mode would immediately be set to unrestricted, allowing any-
one to make any calls. If the mode was triggered from a phone,
the control box would also submit an emergency call.

— Whatever device triggered the mode would be connected to 911.

— An event would be logged on the control box stating what device
triggered it, to track down people setting off false alarms.

— An alarm would sound on anyone’s phone who had been blocked
from switching it on within the past few minutes, allowing them
to make any important calls they had been trying to make. A
message stating that an emergency mode had been triggered would
also appear on the control box.
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102 26. COMPLEX TECHNOLOGY...BETTER?

tabs of internet work or an email in your 150 unread messages. I have even
tried my cell phone. For some people, this works okay, but besides the hassle
of inputting an event using your phone keypad, I don’t always have mine
with me. When I go out, I usually do, but it’s frequently turned off because
I'm in school or something similar. In the rare instances when I actually get
the notice, I do, in fact, remember, but this happens so rarely that it doesn’t
actually help. All this just goes to show that, despite the fact that there
are plenty of complex organization systems that work, if you do something
extremely simple and get in the habit of looking at it, you'll be very well
off. (I once read a story about a professional attending a conference about
cutting-edge mobile technology who was using a paper planner.)

This same thing came into my head when we recently learned about the
accelerator issue in certain Toyota cars. If you're reading this far in the
future or never picked up on it, accelerator pedals were simply getting stuck,
which had been a recurring issue on those cars (nobody apparently saw fit
to fix the problem earlier). The bigger problem, however, was that the brake
pedal was not designed to override the accelerator, since it was computer-
controlled. (Of course, here, a possibly more relevant question is “What
idiot decided that going faster was more important than stopping?”) In fact,
if you held down the brake and then stepped on the accelerator pedal, your
car would still move. In certain cars which recover power when braking,
having the brake electronically controlled is a necessity. But in most of
them, a mechanical brake would have worked just as well, and the problem
would have been simply annoying, rather than life-threatening, when one
could actually stop. What’s the point of adding another unnecessary layer
of complexity?

I've come to the conclusion that simpler things are nearly always better.
Don’t let the crazy marketing fool you.

27: Concept Idea: The Phone
Control System

Note: the Concept Idea is a new series I'm hoping to start describing technol-
ogy I envision. They are not anything that has happened, nor is necessarily
going to happen.

We've all experienced someone’s cell phone ringing at an inconvenient
time. Even more annoyingly, people have developed a nasty tendency to
ignore everyone around them at times when they should be paying attention
and use their phones instead. Even more importantly, there are problems
with people communicating information that is supposed to be kept secret.
This can be done by text message, or by taking a picture (for instance, a
student sending a picture of a test to his friend who is going to take the test
the next period). Some people suggest jamming signals to prevent people
from using their phones in certain places, but this hardly seems like an ideal
solution. Something better would look like this.

Point 1: Control Zones

Any institution that desired to put restrictions on cell phone use could pur-
chase a control box that allows them to do so. With the control box, three
other nodes would be provided, which would end the controlled zone and
form a restricted-area triangle. These nodes would prevent any restrictions
beyond the location of the triangle. When setting up the zone, the people
responsible would have to make sure that the zone did not extend beyond
their own property. (If a conflict were to occur, there could be an inspector
to make people adjust the controlled area.) I don’t know exactly how such a
thing could be set up, but this is, after all, a concept.
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28. SIMCITY, RANDOM FAILURES, AND THE CORE I7

31: Finding Text on a Web Page
Quickly

Chances aren’t bad you already know the basics of this trick, but if you don’t,
it could save you a heck of a lot of time. If you already know the trick, I
have a couple of wicked cool shortcuts you probably don’t know.

(Disclaimer: I only had access to the Chrome and Firefor browsers while
writing this tip. I find that these are the best browsers available today; if you
don’t have one of them, check them out! If you are stuck using a different
browser, these tips will probably work anyway, but I can’t guarantee it.)

Part 1: Searching for Text on a Page
In every modern browser, you can quickly search for any text on the current
page by pressing Ctrl-F (“find”) and typing a word or words in the search

box. In most browsers you’ll be brought to the first result and all results will
be highlighted as you type.

Part 2: Cool Tricks
Now here’s the stuff you probably didn’t know:

1. Alternative Ways to Start Searching

If you don’t like the Ctrl-F shortcut, in most browsers you can use F3 instead.
In Firefox, you can also use a slash (‘/’). Note that this search works slightly
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29. WHO CAN YOU TRUST ON THE INTERNET?

My No-Nonsense Download Checklist

1.

Do you really need this program? If you need a word processor or a
video editor to finish a project, then that’s a good download. If you
were just browsing the Internet and said, “Huh, that sounds cool,”
think for a minute before you decide to try it. If you install it and
don’t need it, not only do you raise your chances of getting hit by
malware, you also clog your PC with unnecessary garbage and waste
time downloading and installing it.

Does the program make any mention of being supported by ads or
requiring other (questionable-sounding) programs? If so, pass it by and
find something else. Although it may seem like a fair tradeoff at the
time, chances are very good you'll regret it later—and such downloads
are far more likely to contain actively destructive or dangerous software.

Does the URL contain a load of unidentifiable characters? I don’t mean
at the end—that’s normal. I mean, instead of, say, http://earth.
google.com/download at the beginning, http://6ths7.free67.info/
73nds. Junk programs, especially ones that will steal your personal in-
formation or reformat your hard drive, frequently have URLs that are
cheap to obtain. Another common trick (for phishing sites too) is to use
something like http://microsoft.d6shc.com. Although many people
say “Oh, it’s Microsoft.com, must be good then”, anyone can change
the first part (microsoft, in this case), known as the subdomain, to
whatever they fancy. The part right before the .com is the only part
you actually have to register.

If the program didn’t pass one of those requirements, or you just aren’t
sure about it, try googling the function of the program. Chances are
very good you'll find another free program with a less questionable
background, and quite possibly better features as well.

If you really want the program and aren’t sure of its legitimacy, down-
load it, scan it with your antivirus program, and back up your files first
or install it on a junk PC just in case. (Of course, you really should
have a valid backup at all times; I've got an upcoming feature on mak-
ing a backup script for yourself.) If your antivirus program comes up
with a warning, ditch it and find something better. It’s definitely not
worth the trouble.

Part IV

Technical Geekery Quick Tips
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116 29. WHO CAN YOU TRUST ON THE INTERNET?

Google products extensively), it somehow seems a lot more impressive and
scary when it’s all in one place.

Check out these three screenshots:

http://www.thetechnicalgeekery.com/images/Googlel.png
http://www.thetechnicalgeekery.com/images/Google2.png
http://www.thetechnicalgeekery.com/images/Google3.png

In the first one, you can see most of the Google searches I made in the
last two days, and that I've made 4,913 searches since Google enabled Web
history. This catches nearly all of the searches I've made on my home com-
puters, since I'm nearly always logged into Gmail, but I’d say that it probably
still only represents about half my searches. (Interestingly, I found that there
were searches on my history page I hadn’t made today, meaning that I had
accidentally left myself logged in on the family computer—oops. If you ever
accidentally leave yourself logged in on another computer, you can log in to
Gmail, click the Details link at the bottom of the page where it says “This
account is open in z other locations...”, and choose Sign Out All Other
Sessions.) Still, Google has stored, and still has accessible, about half of my
searches all the way back to January 2008. That’s kind of cool, and a neat
way to look through what you’ve done on the Internet in the past, but it’s
also naturally a concern if someone else gains access to your Google account
(besides being able to log in and represent you on any Google service, and
some others). The other two shots show other parts of my history, including
all my stored emails, documents, and many phone calls and texts I've made
through Google Voice. Not displayed is also contact information for over 100
people.

The good news is that if you're scared by the web history, you can easily
stop it from collecting items or clear some or all items from the history.
Just open up your Web History from the dashboard and select Pause or
Remove Items, on the left. (It should be noted that Incognito Mode in
Chrome does not prevent Web History from collecting items, although you
are not logged into your account in a new Incognito window and therefore
cannot have your searches collected. If you want to browse totally privately,
stay logged out of your account or pause the web history.) Other services
like Gmail are harder—you can’t really use email without leaving tracks
with someone, be it Google, Microsoft, or your ISP. However, I generally
trust Google with my information; they’ve had a fairly good record of not
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and is significantly more reliable. Unfortunately, only a small number
of people use it, so your use of green toilet paper may annoy people,
and you may have difficulty finding more when you run out. It’s also
the most expensive type of toilet paper.

e Burnt orange toilet paper is uncommon, but it allows you to do basi-
cally anything you want with it. It requires reading a short manual to
familiarize yourself with its workings, and also needs a small amount of
time to install and master. However, once you have done these things,
you'll think it’s great. It’s also completely free.

I think we can all agree on the fact that if popularity concerns were
removed, the blue toilet paper is an absolutely terrible deal and nobody
would use it. Lime green and burnt orange toilet paper would then be the
serious contenders. In this case, I would expect that roughly the same number
of people would choose to use green toilet paper as orange. People who are
willing to spend some money and don’t like learning things would choose
lime green toilet paper, while those who want to save their money and are
willing to work a little bit to have better control of their toilet would choose
orange toilet paper. In this situation, the issue of people having difficulty
using other types of toilet paper would also be diminished—with only two
types of toilet paper in use, and without one having a near-total monopoly,
people would learn the basics of how to use the other type properly, even if
they didn’t like it much.

If you didn’t get it yet, electric blue toilet paper represents Windows, lime
green toilet paper represents the Mac OS X, and burnt orange toilet paper
represents Linux. I may have exaggerated a bit on the instability of Windows,
but I honestly have never used another operating system that occasionally
chooses to melt down at an inopportune time and sit there with a guilty blue
screen facing me. Although occasional slow performance and bugs are a fact
of life with computers, Windows also seems to have more of them than any
other operating system. And it’s not like Windows has a terribly innovative
interface or anything else to particularly recommend it, either. It does, as
with blue toilet paper, have a wide user base (although more and more new
college students, for one, are beginning to purchase Macs), and is compatible
with nearly everything. Even that advantage is beginning to change, as more
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29. WHO CAN YOU TRUST ON THE INTERNET?

30: OS Popularity

I had a question the other day: If everyone forgot everything they knew
about computers, how many people would still be using Windows?

Imagine that you decided you were going to completely remodel your
bathroom. Not being an expert on bathrooms, you don’t know much about
the various toilets, sinks, and bathtubs available, so you talk to a salesman,
and he helps you pick out something that you think will work well. Then he
says that you have a choice between the electric blue and lime green varieties
of toilet paper. Let’s assume that they look equally absurd, and you don’t
prefer one for its color. The salesman tells you that 90% of people buy the
electric blue type. Naturally, you choose the blue, because you assume that
if all those people use it, it must be the best.

But what you don’t know is going to hurt you. Had you taken the time to
do your research, you would have found out that electric blue toilet paper dyes
your toilet a funny color, clogs the drain on a regular basis, and occasionally
even spontaneously explodes. On the other hand, the green kind almost
never clogs the toilet, contains much more toilet paper on the same roll, and
doesn’t lose its dye.

Making the situation even more complicated is the existence of the burnt
orange variety of toilet paper. It is completely free, allows you to control the
exact amount of toilet paper you want to put on a roll (allowing for dispensers
of different sizes), lets you refill your toilet paper roll any time you want,
and clogs your toilet only in very exceptional circumstances. Unfortunately,
you can’t buy it along with your bathroom—you have to install it yourself
later. You also need to read the short manual in order to learn how to use

it correctly. And the existence of this toilet paper is never even mentioned
when you buy your toilet. A small number of people find out about and
properly set up their orange toilet paper and are very happy with it, but
when they try to tell others about the great toilet paper they found, those
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128 31. FINDING TEXT ON A WEB PAGE QUICKLY

But F3 is kind of hard to reach. In both Chrome and Firefox, just pressing
Enter (and Shift-Enter) does exactly the same thing while you're in the
search box. However, this one does have a few limitations: In Firefox, when
searching with / (NOT when using Control-F), this will follow a link if the
text found was in a link. In both Firefox and Chrome, after closing the search
box, Enter doesn’t return to a search, only F3 does.

In Chrome, when you press F3, the text in the search box is highlighted,
allowing you to easily change the word you're searching for if you need to.
Unfortunately, this doesn’t happen in Firefox.

In Firefox, when searching with /, pressing Enter while over a link will
follow it.

Part 3: Internet Explorer 7 Notes

While I won’t exactly consider this a complete test, I got a chance to try this
tip out in Internet Explorer 7. (Note that the current version is 9, so some of
this information might potentially be out of date considering your browser.)

0Oddly, you can’t use F3 to advance to the next match—but it still works
to bring up search in the first place. Go figure. When you press Enter,
it seems that the search function finds the first match after where you
last clicked on the page (though that point isn’t actually displayed in the
browser). You can still use Enter to advance to the next match.
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Pause/Break

Fortunately, pressing this key does not break your computer. In fact, chances
are very, very good that pressing the key will do nothing at all. Believe it or
not, the origin of the key dates back to the days of the telegraph. Telegraph
keys had a switch that would short the contacts of the key, generating a
continuous signal. This switch would be set anytime the telegraph was not
in use—this way, when the operator was ready to send again, he could turn
off the switch and thereby alert the receiving party that he was about to
send. (Additionally, if the signal was broken and no message arrived, they
would know there was a problem with the line.)

When teletypewriters came into common use (they were used for a time
to control early mainframes), the Break key was created to emulate this
functionality. Pressing the key would cause the system at the other end
to terminate a program, prepare for a login, or something similar. (When
controlling a teleprinter at the other end instead of a computer, the printer
would generate a continuous series of punches or DELETE characters, which
was sometimes used to make a loud noise and alert the operator.)

So is there anything you can do with the Break key? Well, maybe. If you
ever run MS-DOS programs, pressing Ctrl-Break may terminate a program.
When your computer is beginning to boot and doing the POST (Power-On
Self Check, where you see the computer’s hardware or manufacturer’s logo
displayed onscreen), you may be able to freeze the output with Pause. But
the only thing that most users are likely to be able to do with the Break key
is to open the System Properties screen on a Windows computer, which you
can do by holding the Windows key and pressing Break.

SysRq

T'm tempted to pronounce this “sys wreck” and say that it makes your system
explode. But it actually stands for “system request,” and goes down in
history as something that was completely superseded and outdated about
twenty years ago, yet still remains a standard feature of PC keyboards. It’s
usually combined with the Print Screen key and accessed by holding down
Alt before pressing the key. The key was originally introduced by IBM as
a way to switch between operating systems. Since then it has had... well,
basically no use at all. A tiny number of systems use it as a sort of “panic”
signal, to trigger a hard reboot or terminate a program.
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130 32. ILOST MY WINDOW!: PULLING A MISCHIEVOUS WINDOW BACK ON-SCREE

on a part of the window you can see (if there is any), or you can select its
taskbar button (so that it looks highlighted, something like what screenshot
2 looks like). Hold down the Alt key and press the spacebar. A menu should
appear with options for managing the window. Choose Move. Slide the
mouse away from the part of the screen the window is stuck in. The window
should move as if you were dragging and dropping its title bar. When you
get it to the location you want, click once. (Alternatively, you can use the
arrow keys to move the window.)
That’s all. Time to get back to work!

36: What The Heck Does That
Key Do?

You know what keys I'm talking about. The ones that say things like Scroll
Lock, Break, and SysRq. When was the last time you pressed one of those
keys? Here’s how they got to be there, what they originally did, and if there’s
still anything you can use them for now.

Print Screen

The Print Screen key barely fits in this category—quite a few people know
what the Print Screen key does, and it’s the only one of these keys that I use
regularly. Originally, as its name suggests, the Print Screen key dumped the
contents of the screen to the printer. So why doesn’t it perform this handy
function today? Well, quite simply, graphical user environments. This key
was envisioned when text-based operating systems like MS-DOS were the
norm, and printing text was quite sensible. But when Windows came along,
the Print Screen key had to be deactivated in Windows—dot-matrix printers
and graphics don’t mix, and even if your printer printed graphics, that would
have been a lot of ink. (Dot-matrix printers are the really noisy kind that
operate by punching pins in the shape of letters. If you go to a few stores
with old cash register equipment today, you might still encounter a dot-
matrix receipt printer.)

But not being able to get a record of the current contents of the screen
wasn’t a good solution either, so the function was modified to copy an image
of the screen to the computer’s clipboard instead. This remains its function
today. If you've been reading along with this newsletter every week, you've
probably encountered a few of my screenshots—an common way to create a
screenshot is to press the Print Screen key, paste the image into an image
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132 33. BIG, IMPORTANT KEYBOARD SHORTCUTS

I can’t tell you how many minutes of my own life I've spent watching
people slooowly selecting text, then moving their mouse all the way across
the screen to select Edit — Cut from a menu, when they could be done
pasting the text already. If you don’t already use these shortcuts, learn
them. Paste a sticky note on your monitor until you've got it down.

Control-Z is a nice extension to X, C, and V. All four keys are right next
to each other and can be easily operated with one hand while selecting things
with the mouse with the other. (Unless you use a non-standard keyboard
layout, like Dvorak. Then you're out of luck on that particular front.)

Part 2: Slightly More Advanced Stuff

These aren’t really “advanced,” just lesser-known and less important. If I
could only teach someone 10 keyboard shortcuts, these probably wouldn’t be
among them—but they do still come in handy.

e Control-A: Select all text in the current document or text box.

Sometimes you need to copy an entire document and paste it somewhere
else (for example, into an email). Or you might have finished writing a
long comment in a text box on a website and want to save it yourself.
This shortcut saves you from spending a few seconds trying to highlight
a long document or blob of text.

Control-Y: Redo an action.

If you undid your actions one too many times, the Redo command is
your friend. It’s an undo for the Undo command. A few programs use
the keystroke Ctrl-Shift-Z instead, but it works the same.

Confusingly, Redo also has another function in many programs (like
Microsoft Word)—if you just moved or typed something and your last
action wasn’t an undo, hitting Redo will repeat your last action.

35: Zooming In and Out In a
Zoom

Ever tried to make a picture, Word document, or web page display bigger or
smaller? You probably found it was an exercise in frustration because you
kept having to find the zoom options when you didn’t get the amount quite
right—but that’s because you didn’t know about this tip. Here are two ways
to quickly zoom in and out that work in nearly every program that supports
zooming.

Method 1: Using The Mouse

Hold down the Ctrl key, then turn your mouse wheel away from you to zoom
in or towards you to zoom out.

Method 2: Using The Keyboard
e To zoom in, press Ctrl - +.
e To zoom out, press Ctrl - - (Ctrl plus a hyphen).

e To return to 100% zoom, press Ctrl-0.
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134 34. SLASHES AND BACKSLASHES, OH MY

Part 2: When to Use (Back)slashes

1. In filename paths:

Here are some ways of specifying the location of a file, several of which you
probably recognize:

1. http://www.google.com

2. C:\Windows\system32\progman.exe
3. /home/soren/code/scripts/m.sh

4. \\SERVER\Music

5. smb://SERVER/Music

(1) is a URL for a page on the World Wide Web. Web addresses always
use forward slashes. You can probably get away with typing backslashes and
have the page still load, but doing so is poor form and may occasionally not
work. Please don’t say “backslash” when reading a web address—it annoys
people who know about these things to no end.

(2) is a Windows file path. These paths always use backslashes. You can
supposedly use forward slashes if you want, but many programs will not ac-
cept paths typed with forward slashes.

(8) is a UNIX or Mac OS X style path. These always use forward slashes.
These systems will usually not accept backslashes, because the backslash is
used for something else (more on that in a minute).

(4) is a UNC path, used to specify the location of a device or file on a net-
work in Windows. This uses backslashes, though forward slashes will often
work.

(5) is another way of specifying a network resource, usually used on UNIX-
like systems. This uses forward slashes.

In short, Windows uses backslashes, while UNIX and Mac OS X systems
use forward slashes. Most importantly, Web addresses always use forward
slashes.
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2. Other Uses
Forward slashes can also be used:
e as a symbol for division (as in 6/3)
e to precede a command in a chat client or other program (as in /quit)
e to show italics when only plain text is available (like /this/)
e To indicate command-line options in Windows (dir/p)
Backslashes can also be used:

e as an “escape” character, to modify the meaning of the following char-
acter. This is a common feature on Unix and Mac OS X command
lines. For example, if a space would normally mean the end of a com-
mand or name, but the command or name contains a space, it would
be written like this: word1l\word2

to indicate integer division, where any fractional result is cut off (7 \ 2 = 3)

to indicate that a line of text or program code does not end but should
be carried over to the next line (this is the first part of the line \

and this is the second part)

There are even more uses for these two simple characters in computing; if I
didn’t bore you out of your mind, you can check out Wikipedia:
http://en.wikipedia.org/wiki/Slash_(punctuation)
http://en.wikipedia.org/wiki/Backslash.
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144 37. SIX HANDY BROWSER SHORTCUTS

6. Press Control-Shift-T to reopen a tab you just closed. This is really
nice when you accidentally close a tab, or if after a few minutes you
realize you weren'’t really done with that reference page. It sure beats
having to open your browsing history and find it again.

43: Switching Quickly Between
Windows

Here’s another shortcut that everyone should learn. It’s a godsend if you're
switching repeatedly back and forth between two windows, and useful even
if you aren’t.

1: Alt-Tab

Pressing Alt-Tab will allow you to switch windows to the most recently used
window. If you continue to hold down Alt after releasing the Tab key, the
window switcher will remain open and allow you to select any other window
as well.

If that sounds confusing, try it out, and it will become clear immediately.
(Mac OS X users: Use Command-Tab instead of Alt-Tab.)

The behavior of Alt-Tab is actually a lot more complex than it looks—if
you're interested in the details, see the Wikipedia article. But the main thing
you should remember is that it lets you easily toggle between two windows.
Next time you have to copy and paste text several times between windows,
try pressing Alt-Tab instead of clicking each of the windows in turn, and
keep your hands off the mouse!

2: Similar Shortcuts

On Windows Vista and 7, Windows-Tab (the Windows key is often la-
beled with a flag icon) will do roughly the same thing, but display a fancy
Rolodex-style preview of the window. On earlier versions of Windows, press-
ing Windows-Tab will select each program on the taskbar in turn; you can
press Enter to select one.
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146 38. HOW TO PLUG IN A USB CABLE THE RIGHT WAY THE FIRST TIME

hub/case/other device. That way I don’t have to think about it.

42: A Little Refreshment: Reload-
ing the Current Page

If a website has changed, you often don’t see the changes right away. A few
sites, such as Facebook, do dynamically update the website, which usually
makes this tip unnecessary. However, occasionally Facebook and similar
websites do fail to update, and most websites will still need manual refreshing.
Here’s what to do if you suspect the website on your screen isn’t the most
recent version.

1: Refreshing a Page

The Refresh button has been moved all over the screen by many major
browsers lately, but it’s usually either next to the Back and Forward buttons
or at the end of the address bar.

To reload the page, just click the button. Most of the time this will load
the most recent copy of the page with no problems.

2: Really Refreshing a Page

Sometimes your browser thinks it’s smarter than you, and when you push
Refresh it just loads a copy from your computer’s cache. (The cache stores
copies of frequently accessed Web resources on your computer so that pages
can be loaded more quickly.) So even after you've pushed Refresh, you may
not actually have the site’s most recent version.

If you're suspicious that you still don’t have the latest version of a site,
simply hold down the Ctrl key while hitting Refresh. This will disallow
loading from the cache and force a full copy of the page to be downloaded
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148 39. TIPS & TRICKS FOR FILLING OUT FORMS

box that you can type text into. Usually you can type whatever you
want into here, though some text boxes may have validation—for in-
stance, an email address has to contain an at sign and a dot, and the
CAPTCHA code where you have to type in the funny letters to prove
that you're human has only one correct answer.

e Drop-Down Menu (or simply drop-down): A (usually gray) box with a
little arrow on one end. When you click on it, a list pops open and you
can scroll through it and select one of the choices. These are usually
used when there are a lot of options, but sometimes form designers
might put short lists in a drop-down.

e Check Box: A small square box; when you click on it, a check appears
or goes away. This is (usually) for on/off and yes/no questions only.

Radio Buttons (or option buttons): Little round buttons, typically used
for short lists of options. When you click one of the radio buttons, any
previously selected one gets unmarked.

e Field: Any one location asking you to enter data (i.e. “first name”,
“state”, “telephone number”, and so on).

In addition, forms can contain text, lines, and pictures, but you can’t enter
any information with these.

2: Moving Around A Form

Your TAB key is your biggest friend when filling out a form. It will advance
automatically to whatever the creator of the form has defined as the next field
(hopefully this is an order that makes sense to you!). If you accidentally skip
a field or need to go back and change something, you can press Shift-TAB.
When you use the key to move into a text box that already has something
in it, it will usually highlight any previous text so that you can just start
typing over it (be careful that you don’t accidentally delete anything).
When you’re moving through a form that has a text box, then a series of
check boxes, then another text box, you can save a fair bit of time (and a lot
of effort) by avoiding the mouse, because you don’t have to keep switching
from mouse to keyboard. If you use the TAB key and the following tips, you
should have no reason to touch your mouse. (If you're filling out a form that

41: Two Shortcuts for Working
With Files

Ever opened up a really, really long list of folders and hunted through the list
trying to find a folder or file? Or maybe the same thing happened on your
desktop—you knew the name of what you're looking for, but you couldn’t
see it. Here’s a better way.

Tip 1: Jump to a File or Folder by Typing its Name

This trick is so simple you’ll probably be surprised you never knew about it.
If you know the name of a file or folder located in the folder you're currently
browsing, but you can’t see it, simply click once on any file or folder you can
see, then start typing the name of the folder. You’ll be moved to the folder
as you type. (Don’t stop typing for more than a second or so, or the search
will start over.)

This works in a File — Open dialog box, in a Windows Explorer/Finder/Nautilus

window, or on your desktop, in all operating systems.

Tip 2: Rename a File Quickly

Renaming a file can be a little bit annoying sometimes, especially if you have
to rename quite a few files. You can right-click it and choose Rename, or
you can click twice slowly on the name of the file. Either way, the process
requires some clicking, and if you're renaming a bunch of files you have to
keep switching between the keyboard and the mouse.

Instead, just select the file and press F2.
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150 39. TIPS & TRICKS FOR FILLING OUT FORMS

but after you make a selection it is impossible to return to having nothing
selected.

Unlike other sets of elements (like multiple check boxes) radio buttons are
selected as a set when tabbing, so pressing Tab while the first radio button
is selected will tab to the field after all the radio buttons, rather than to the
next radio button.

To select the first radio button, you can press the spacebar. To select any
others, simply use the arrow keys, and buttons will begin being selected as
you press the keys.

Submitting

When you finish entering your data, you can press Enter to send it. At this
point, Murphy’s Law states that the site will usually return an error and
require you to retype some or all of the information again (often because you
missed the little tiny button that states you agree to the terms and condi-
tions that have been read by approximately five people, or else because you
mistyped the eye-straining verification code). If it’s only one field, clicking
on it and fixing it is probably best, but otherwise you can reuse the tips
above.
If you haven’t seen the screencast yet, I suggest you watch it now.

40: Using Your Middle Mouse
Button in Your Browser

Most people don’t even know what a middle mouse button is, let alone how
to use it. But it is enormously useful. Here are a few ways to deal with tabs
in your browser much more easily.

But I don’t have a middle mouse button/—That’s what 90% of people
I inform about this tip say. Of course, they’re wrong—unless you have a
really old mouse, you have a middle mouse button. To middle-click, you
just press down on the scroll wheel. (If you have a laptop, you can usually
emulate a middle-click by pressing down the left and right touchpad buttons
simultaneously, and if you have a Mac with one mouse button you can hold
down the Command key and click.)

A disclaimer: T only had access to the Chrome and Firefox browsers while
writing this tip. While I personally believe you should be using one of these
two browsers, I understand you may not be, in which case these tips will
probably work but I can’t guarantee it.

1: Closing a Tab

To close a tab, you could aim for the little tiny z button in the corner of the
tab. Or you could just middle-click anywhere on the tab and save yourself a
couple of seconds every time you close a tab.

2: Opening a Link in a New Tab

I couldn’t live without this trick. Sometimes you're researching a topic and
come across a link that looks interesting, but you want to be able to easily
return to the current page. Don’t follow the link (and maybe several more
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44. HOW TO TOUCH UP YOUR LCD MONITOR

Dip a cotton ball into the rubbing alcohol and clean off the monitor
with it. Reportedly, this is the method that manufacturers use to clean
the displays as they reach the end of the assembly line; regardless of
whether that’s true or not, it works well.

Wipe the monitor dry with the cloth.

Take the eraser and carefully rub it onto all the scratches and spots,
and watch as they magically disappear, or at least get better. It’s fine
to use some pressure as long as you work deliberately and don’t smash
the monitor.

Blow off the eraser dust if there’s any left, and clean the monitor again.
You can repeat steps 2-6 as many times as you want, until you're
satisfied with the result. It may take a couple of runs to completely
get rid of the problems.

When you're done, press F11 or Escape, depending on your browser,
to get out of the full-screen mode.

Of course, this method isn’t going to work for horrible gashes down the
center of your monitor, but for relatively minor blemishes, it works like a
charm. I had a damaged spot that was about an inch square, and after doing
this I can’t even see it anymore.
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much sense. I would say I was wrong about the operator, but us-
ing it from Advanced Search confirmed that I was correct.) Ezample:
link:www.thetechnicalgeekery.com

o If you want to see pages that Google thinks are related to a site, use
the related: operator (oddly enough). “Google thinks” is a key phrase
here; sometimes it works well, and sometimes it doesn’t. For example,
related:google.com returned other search engines, related:bit.ly
returned other URL shortening services, and so on. But related:thetechnicalgeekery.com
returned seemingly random results. Ezample: related:www.snipurl.com

Many of the above options, if you want to cut down on the ones you
memorize, can be accessed from the info page for that website, accessed
with the info: operator. Strangely enough, it only works for some web
pages, and of course you have to know the URL to be able to use it.
Ezample: info:www.google.com

If you happen to know a phrase that’s in the website’s title (the text
that appears in the title bar of the window and in bookmarks), you can
use the intitle: operator to narrow your search quite dramatically—in
my test, there were only four results, and they were all my web page.
Ezample: intitle:"the technical geekery"

If you want to search for a range of numbers, there’s no need to type 2
OR 3 OR 4, and so on for as long as you want, or just put in a * and
get some irrelevant information. Instead use a .. between the numbers
to search for any of those numbers in that position. Note that this is
not changed by placing the term in quotation marks. Ezample: 2. .20

o If you know part of a URL, you might be able to find the site with the
inurl: operator. Strangely, I noticed that there was at least one URL in
my example that didn’t actually contain the string thetechnicalgeekery.
Ezample: inurl:"thetechnicalgeekery"

Advanced Image Search

When you're searching images, you might want to filter based on license (can
I freely reuse this picture?), or size (is this going to fit on my PowerPoint

slide?). Instead of memorizing a bunch of operators for something most
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45. THE ESCAPE KEY: GETTING OUT OF STUFF

e There are more uses that I didn’t mention—you can use it almost any

time you want to cancel an action you're in the middle of taking. If
you're not sure if Escape will work, feel free to try it—pressing Escape
will never cause anything particularly untoward to happen (unless you
just spent five hours filling out a dialog box, in which case you have
other problems).
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If you remember a good part of a phrase, but don’t know some of the
words in it, an asterisk (*) matches any single word. This comes in
real handy if you're thinking of a saying or cliche and can’t remember
the entire thing. (Note that Google does not support conventional
wildcards, where a * would mean zero to infinity characters.) Ezample:
Whatever can go * will go wrong

If you want the definition of a word, use the define: operator. If you
click the “More Info” link, Google will show a nicely formatted list of
different dictionary websites’ definitions. This is really nice because 1
often find that one dictionary lacks important aspects of a definition,
but several read together generally give a very good impression of the
word, and allows you to mix and match parts if you need to write your
own definition. Example: define:example

Need a quick calculator? Just type in your equation, and Google will
solve it easily. Logarithms, parentheses, trigonometric functions, and
so on are all handled. ~ does powers, and % does modulus (remainder).
It respects order of operations, so you can probably put in some fairly
complicated equations. That said, if you're doing serious math, you're
better off going to Wolfram Alpha (http://www.wolframalpha.com/),
which has nice formatting features and can handle serious calculus and
data manipulation. Ezample: 8+5% (4+3)

Need to convert units of measure? Just type what you want to convert
and the units you want to use into the search box, and unless it’s some-
thing really obscure or nonsensical (like 18 feet in hours), Google
should have no problem. It even supports metric prefixes (10 pounds
in nanograms) and silly conversions (18 light-years in inches).
It can expand most common abbreviations, if you hate typing that
much. Of course, if you make a mistake and don’t get any results,
you'll land on a normal search page, which is unlikely to have anything
remotely relevant. Sometimes the autofill feature will give you the an-
swer before you're even finished typing. Erample: 56 tablespoons in
cups

You can convert number systems the same way. You're unlikely to
ever need to convert a number to binary or hexadecimal, but you never
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For instance, I run a Google Alert (which is basically an automatic
Google search) on windows 8 in order to keep track of the development
of the next version of Windows. This search occasionally brings up
phrases like 8 years ago, some windows were broken... or Using
Microsoft Bob 8 times on Windows 95 can be a problem.

The fix: If you want all your terms to be in order and together, put it
“in quotation marks.” However, quotation marks should be used only
for a good reason; if you put every search you make in quotation marks,
you're going to miss perfectly good results that happen to have a word
or two slightly different.

Google strips away connecting words, like and, to, the, and so on. This
can sometimes lead to unexpected results. For instance (for lack of a
better example), say I wrote a book about my online presence called
The Life and Death of scorchgeek. If 1 simply typed in The Life and
Death of scorchgeek into Google, the parser would strip that down
to life death scorchgeek, which may well not be what I intended.

The fix: If you don’t want your connecting words to get messed with,
put them in “quotes”.

Google is not case-sensitive, and cannot be made to respect case. But
when were you planning to use that anyway?

Google does not support any form of wildcards or regular expres-
sions. So I can’t type, for instance, the webx to get the webpage,
the website, the web page, etc. It should be noted, however, that
Google does automatically expand many words, so that win may be
expanded to winning, won, and so on, which is almost a substitute
(although it doesn’t offer you nearly the same level of control).

If you're seeing tons of results about something irrelevant, and they
have a common word or phrase, put that word or phrase in quotation
marks, after a minus sign, like so: -"buy today!". Note that unlike
some search engines, typing NOT will not have the same effect as the
minus sign; in some other search engines, annoyingly enough, exactly
the reverse is true. You can use the minus sign with as many words
or phrases as you want; just put a separate minus sign in front of each
of them. (Note: There needs to be a space before the minus sign, and
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166 APPENDIX A. KEYBOARD SHORTCUTS
Keystroke Effect See page
Alt-Tab Switch between open programs. 157
Alt-F4 Close the current program. 20
Ctrl-Tab Switch between tabs (in browsers) or documents

(in word processors).
Ctrl-F4 Close the current tab (in browsers) or window (in
word processors).
Ctrl-W Close the current window (sometimes).
Ctrl-F Find something on the current page. 125
Ctrl-A Highlight the entire document or page. 132
Ctrl-S Save the current document. Works in both word
processors and browsers.
F12 Save As. 36
Ctrl-X Cut. 131
Ctrl-C Copy. 131
Ctrl-V Paste. 131
Ctrl-Z Undo. 131
Ctrl-Y Redo. 132
Ctrl-Alt-Del ~ The infamous “three-finger salute.” Opens a 46
screen of options for logging off or ending unre-
sponsive programs.
Ctrl-Shift-Esc A faster way to get to the “ending unresponsive 46
programs” part of Ctrl-Alt-Del.
F1 Get help. 36
F5 Refresh the page. 155
F7 Do a spell-check. 36
F11 Make your browser full-screen. 67
Tab Move between fields in a form. 147
Escape Get out of dialog boxes, stop dragging stuff you 161
didn’t mean to start dragging, and more.
Print Screen  Take a screenshot and copy it to the clipboard. 139

Appendix B: Searching Google

This was originally published as a special edition of the Technical Geekery
Tips: January/February 2010. (It was actually not published until Septem-
ber 19, but I apparently still hoped to catch up at that point.) However,
Google changes rapidly, and so this is not identical to that—it’s an updated
version.

About 95% of the time, if you have just about any question, you can go
to Google and type in the first couple of words that you think of, and in a
couple of seconds you have your answer. But sometimes it doesn’t work out
quite that way. This guide tells what you should do when you don’t get what
you wanted, and some more tips and things you didn’t even know Google
could do.

A note on syntax

Because of all the different special characters that have meaning in searches,
I'm going to set all my example searches in monospace. Any special charac-
ters should be interpreted as an intentional part of the search.

Also, it should be noted that Google is always changing, and some of this
information may be incorrect now or in the future. (This is already a second
version.) Additionally, Google is so complicated that it sometimes confuses
everyone, even when they have all the rules down and think they know it all.
Things you really didn’t expect or seem to not follow the rules may show up.

Basic Tips

o If you don’t get what you want right away, start by changing a cou-
ple of words around. If your initial query was find Windows desktop
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APPENDIX C. QUOTATIONS
After being told to check the pattern of the switches on the side of a
cash register: “Yeah, you know, I removed them. With a chisel.”

My dad once worked with a lady who thought she knew everything.
On one particularly memorable occasion, she said, “I know Mouse!”

Want a good oxymoron? Microsoft Works.
Ever noticed that MACS backwards is SCAM?

They say that if you play an AOL CD backwards, you hear Satanic
messages. But that’s nothing. If you play it forwards, it installs AOL!

To err is human; to really foul things up requires a computer.
“Do I need a computer to run this software?”
“Do I have to be online to backup online?”

After copying a file and receiving the message one file copied: “It says
one copy filed.”

“It says I have 2 zillion bytes available, and I need 8 zillion.”
“Well, we have the CD, but we can’t find the ROM!”

In response to asking a user why he included the line x = z multiple
times in his program code: “So z doesn’t lose its value.”

“I don’t have a space bar.”
“Oh my gosh! Plug it out!”

In response to asking if the caps lock light was on: “I’'m not a computer
person.”

“Do you want a forward backslash?”

“And you are typing the underscore character?” / “Yes, I call it the
dash.”

“My modem was hit by lightning. Can you email me another one?”
(This guy didn’t have any basic logic, besides not knowing that you
cannot email hardware.)
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backslashes, see slashes and backslashes  tabs, 11

Flash
Caps Lock, 15, 71, 72 in Chrome, 71
cell phone control system, 103 forms, filling out, 147
checking program version, 74
Chrome, 71 input methods, 87
bookmarks, 74 errors, 88, 89
Flash, 71 thought, 90
searching pages, 126 touch screens, 88
complexity vs. simplicity, 101 touchpads, 90

; ; typing, see touch typing
displaying on desktop voice recognition, 89
a toolbar with contents of a folder, ;¢ 1an: ty of Windows, 32, 119
74 ) 92,

installing Windows, 93
version of Windows, 64

Internet

efficiency, 131, 147 browsing full screen, 67, 159
desktop shortcuts, 16, 20
keyboard shortcuts, 143
middle mouse button, 151

email services, 57
Excel, resizing columns, 36

files, deleting, 11 refreshing the page, 155
Firefox RSS, 61
add-ons, see extensions search box, 54
bookmarks, 54 searching the Web, 167
browsing full screen, 67 working with tabs, 151
extensions, 71 zooming, see Zooming
keeping tabs open, 57 Internet Explorer 7
links toolbar, 47 browsing full screen, 67
RSS, 61 finding text, 128
searching pages, 127 missing menu bar, 47
starting quickly, 69 RSS, 61
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tech support, 97
toilet paper analogy, 119
touch typing
Dvorak, 62
me learning, 87
security benefits, 80
touching up LCD monitors, 159

unusual keys, 139
Insert, 140
Pause/Break, 141
Print Screen, 139
Scroll Lock, 140
SysRq, 141

Vista, 44, 48, 54, 60

versions, 50

window stuck off-screen, 129
Windows background music, 70
Windows Explorer
changing folder icons, 67
deleting files, 15
jumping quickly to folders, 153
renaming drives, 34
renaming files, 153
resizing columns, 36
rotating pictures, 16
slideshow, 16
toolbar labels, 25
toolbars, 32
views, 27, 36

zooming, 59, 137
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